CHAPTER 3

Establishing Existing
Conditions Using
Survey Data

With our tour of the AutoCAD® Civil 3D® software user interface and our study
of its capabilities behind us, it’s now time to do what we came here to do: Use
Civil 3D to complete a land-development project. To begin to understand the task
ahead, let’s imagine land development as creating a sculpture, but on a very large
scale. If sculptors were to create works of art from wood, they would probably
begin by studying the original piece of wood, assessing its dimensions, shape, and
surface features. These elements would all factor into how the sculptors would
approach their work. A sculptor with some computer savvy might even model the
original piece of wood on a computer and plan out each cut of material.

In this chapter, we are going to explore the first activities that are per-
formed during a land-development project: the measurement, mapping, and
modeling of the land in its existing form. To plan out how the land will be
reshaped, you must first understand how it’s shaped right now. This is analo-
gous to the sculptor’s measurement and assessment of their medium. The
measurement and mapping of land is known as surveying, and the data that
is collected during the process is known as survey data.

In this chapter, you'll learn to:

Understand the purpose and function of survey data
Create a survey database
Import survey data

Automate field-to-finish
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What Is Survey Data?

Think back to the last time you played connect-the-dots to draw a picture. Ever
wonder who made the dots and how they were made? I'm no expert, but I'm
guessing someone took the original picture, laid a piece of tracing paper over it,
and made dots along the edges of key features in the picture. Someone skilled at
this would make just enough dots to define the features but not so many as to
make them confusing or wasteful. The dots are a way of capturing an image and
transferring it to another location.

In land development, the land is the picture and the surveyor is the one who
makes the dots—referred to as points. Obviously, tracing paper can’t be used, so
the surveyor lays an imaginary grid over the land (a coordinate system) and cre-
ates the points as information by recording their coordinates on this grid paper.
The tools the surveyor uses are extremely accurate and are capable of capturing
the location of each point within a tolerance of about 1/8 of an inch (3 mm).
Something different about the surveyor’s “dots” is that their location is recorded
in all three dimensions. This enables a technician to play connect-the-dots in
3-D to create a 3-D model in addition to a 2-D map of the features of the land.
Another difference is that a surveyor’s dots have description codes next to them
instead of just numbers. A description code identifies the type of feature that a
dot, or point, is intended to represent (see Figure 3.1).
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FIGURE 3.1 Surveypointsshown as dots, giving a sense of how they are used to
create mapping

If you're thinking that it takes a lot of points to capture several acres of land,
you're absolutely right. How can you keep track of all those points? How can
they be easily turned into a 3-D model of the land? Is there some way of auto-
mating the connect-the-dots process? Civil 3D has the answers to these ques-
tions, and in this chapter, you’ll learn how you can use Civil 3D to transform
raw field points into maps and 3-D models of the land.
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Creating a Survey Database

REALITY CAPTURE

The technology of reality capture has become more and more common in the
last few years. Reality capture refers to the use of high-density laser scanners to
collect millions or even billions of data points. The resulting data is often referred
to as a point cloud because, due to its density, the data often looks like a cloud
or fog. With this approach, there is no need to play connect-the-dots because
the data points are so close together that they define the shape of the land.

Although it’s not covered in this book, you should know that Civil 3D has the
ability to import and use point cloud data to create a model of an existing piece
of land. The image here shows an example of point cloud data that has been
imported into Civil 3D.

Creating a Survey Database

In Chapter 2, “Leveraging a Dynamic Environment,” you learned about the
importance of relationships in Civil 3D and saw firsthand how Civil 3D makes
use of interactions between different object types. When you're dealing with
survey data, these relationships are managed in a survey database. The raw data
is linked with the screen representation of the points in the survey database,
which is linked with the linework generated by connecting those points, and

so on. The survey database is unique in Civil 3D in that it’s stored outside the
drawing file.
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I Exercise 3.1: Create a Survey Database

If you haven't already In this exercise, you'll create a survey database.
done so, download

and install the files for D 1. Open Civil 3D, and click New on the application menu. When prompted
Chapter 3 according to for a template, browse to the Chapter 03 class data folder and open

theujstructlons !n this Essentials.dwt.
book’s Introduction.

— 2. Click the Survey tab of the Toolspace.

s B 3. Right-click Survey Databases, and select Set Working Folder.

visible, you can click 4. Browse to and select the Chapter 03 class data folder, and click OK.
Toolspace on the Home
tab of the ribbon. If
the Survey tab is not
visible, click the Survey THE SURVEY WORKING FOLDER
icon to the right of the
Toolspace icon.

The working folder is simply the location where survey databases are stored.
In this exercise, you'll create a survey database named Essentials. This will

— create a folderin Chapter 03 named Essentials.

In Prospector,
you'll see a series of
Essentials survey

databases that you'll 5. Right-click Survey Databases, and click New Local Survey Database.
use in upcomin
exe,dse’; ? 6. Type Essentials as the new database name, and click OK.

The Essentials database is now shown on the Survey tab. Note the
components of the survey database, such as Import Events, Networks,
Figures, and Survey Points (see Figure 3.2). The survey database estab-
lishes and manages relationships between these different components.

o7 T -

%E Essentials
Q Import Events
?9 Survey Queries
[E Metworks
[Iﬁ] Metwerk Groups

[h Figures

[E:] Figure Groups
& Survey Points
i) Survey Point Groups

FIGURE 3.2 TheEssentialssurveydatabase shown in Prospector after the
completion of step 6
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7. Close the drawing without saving.

There is no “Complete” drawing for this exercise because you did not modify
a drawing file. You did create a new survey database, but it’s currently empty.
In the next exercise, you'll use the Essentials 1 survey database, which has
already been created for you.

Importing Survey Data

After creating a survey database to receive the data, the next step is to transfer
the raw data into Civil 3D so that the analysis and mapping can begin. There are
several ways to accomplish this, but in this chapter you're going to do it the way
a surveyor would do it. The process of importing data requires some important
questions to be answered. For your first try, however, you're going to accept all
the defaults and see what happens.

Exercise 3.2: Import Survey Data s
In this exercise, you'll import survey data into a survey database and into a Ifyou haven't already
drawing. done so, download
. . and install the files for
1. Open the drawing named Import Survey Data.dwg located in the Chapter 3 according to
Chapter 03 class data folder. the instructions in this
) ) book’s Introduction.
2. On the Home tab of the ribbon, click Import Survey Data. g
3. Select the Essentials 1 survey database, and click Next. _
4. Under Data Source Type, select Point File. Ifyou don't see any
5. Click the plus icon under Selected Files, and browse to the s s ki

bases listed, go back
Chapter 03 class data folder. and complete steps
2—4in Exercise 3.1.
The Essentials 1
database is the result
of correctly completing
the previous exercise.
This database is pro-
vided to ensure that
you start the current
exercise with the cor-
rect version.

Chappell, Eric. AutoCAD Civil 3D 2016 Essentials, John Wiley & Sons, Incorporated, 2015. ProQuest Ebook Central,

http://ebookcentral.proquest.com/lib/osu/detail.action?doclD=2052358.

Created from osu on 2017-07-11 08:10:12.
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SURVEY DATA SOURCES

Survey data can come in several forms, depending on the hardware and/or
software used to create it. Here are a few of the most common forms:

Field Book File Thisis considered a legacy format unique to Autodesk
products such as Land Desktop and older versions of Civil 3D. Many surveyors
have moved on from field book files but some have done so fairly recently. For
that reason, you might still find them to be somewhat common. One difference
with field book files is that they can store the measurements exactly as they
were taken in the field. The other formats listed here contain points that have
been reduced to coordinates.

LandXML File Many civil engineering and surveying programs can export
data in the form of LandXML, including Civil 3D. This nonproprietary format
enables data to be exchanged between programs created by different software
companies.

Point File The point file is probably the most generic and universally accepted
way of delivering point data. This type of file is plain text and can be opened in
a program like Microsoft Notepad. Regardless of age, cost, or origin, nearly all
surveying and civil engineering programs are capable of producing this type of file.

Points From Drawing With this option, you can open a drawing that
already contains points and add them to your survey database. Remember that
the survey database is stored outside the drawing, so the points you see in the

PNEZD represents drawing are a representation of what is stored there.

the order of the data
columns in the text
file: Point number,

Northing, Easting, Z X o .
L e 6. For Files Of Type, select the Text/Template/Extract File (*.txt) option.

and Description. Then select Topo Survey.txt, and click Open.

e 7. Under Specify Point File Format, scroll down and select PNEZD
(Comma Delimited).
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10.

11.
12.

13.

You can view the results of successfully completing this exercise by opening
Import Survey Data - Complete.dwg. The survey database named Essentials 2
is provided for the next exercise and matches what you should have at the end of this

Click Next. In the Specify Network dialog box, note that <none> is

selected for the current network. Click Next.

In the Import Options dialog box, check the boxes next to Process

Linework During Import and Insert Survey Points.

Verify that Current Figure Prefix Database and Current Linework

Code Set are both set to Sample.
Click Finish.

Zoom in to the drawing, and examine what you see (see Figure 3.3).

%

x

*
x
1

5

E
i3

FIGURE 3.3 Sofar, importing data shows only a bunch of relatively

meaningless x markers in the drawing.

Save and close the drawing.

exercise. It contains the same points you just imported.
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Measurements can be
linked so that accuracy
can be adjusted across
the entire project
simultaneously. The
survey data in this
exercise does not
contain any of these
relationships, so no
network is needed.

You may need to exe-
cute the Zoom Extents
command to bring
the points into view.
To do this, type ZE at
the command line and
press Enter.
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IMPORTING POINTS WITHOUT A SURVEY DATABASE

Sometimes you may want to import points straight into your Civil 3D drawing
without the extended data-management capabilities of the survey database. You
can do this using the Points From File command on the Insert tab of the ribbon,
as shown in the following illustration.

Home [Insert’ Annotate Y Anal fiew Manage Out

5 %% Land Desktop  # Import Survey Data Create

B LandXmL o Polntsf'ﬁm File e | Edit e

Import IMX storm Sewers T Edit Attributes -

Import v Block

The resulting dialog box (shown next) provides only one choice for file format—a
text file—and no association with a survey database or linework code is set.

: ,

Selected Files:

File Name

Spedfy point file format (fitering OFF):

ENZ {comma delimited)
External Project Point Data. ..
XYZ_Intensity (space delimi...
Autodesk Uploadable File

Preview:

[] Add Peints to Peint Group.

Advanced options
Do elevation adjustment if possible
[ Do coordinate transformation if possible

Do coordinate data expansion if possible

For that reason, some of the features you’ll learn about later in this chapter will
not be utilized. These include the automatic generation of linework, accuracy
adjustment, and others.

Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.

(Continues)

Chappell, Eric. AutoCAD Civil 3D 2016 Essentials, John Wiley & Sons, Incorporated, 2015. ProQuest Ebook Central,
http://ebookcentral.proquest.com/lib/osu/detail.action?doclD=2052358.
Created from osu on 2017-07-11 08:10:12.



Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.

Automating Field-to-Finish

IMPORTING POINTS WITHOUT A SURVEY DATABASE ((ontinued)

The differences continue as you work with the points you've imported. Points
created without the management of the survey database are easily edited. You'll
find that points created using the Points From File command can be moved as
easily as moving a circle or a polyline. They can also be freely edited using the
Properties window. Using the Points From File function is definitely quicker
and simpler than using the Import Survey Data command; however, there are
considerable differences in functionality. When you choose which method to use,
be sure to consider the level of protection, ease of editing, ability to generate
linework, and interrelationship between points and survey measurements. Each
method serves a different purpose and should be chosen appropriately.

Automating Field-to-Finish

The term field-to-finish refers to the process of transforming raw survey field
data into a finished drawing. Before computers, the point data collected in the
field was plotted on paper by hand, and draftspeople skillfully connected the
dots and employed other methods to create the desired topographic map. The
process was manual in the truest sense of the word. Next came the first CAD
programs, in which points could be plotted on a computer screen and the dots
connected using primitive entities such as lines, arcs, and polylines. This is what
many would now refer to as a “manual” process.

As you might guess, the process of making a drawing out of point data is
quite tedious and presents an opportunity for automation. Imagine using the
result from the steps in the previous section (see Figure 3.3) to create a map
of the land. With no information accompanying the points, it would be nearly
impossible. In the following sections, you’ll see how to use several Civil 3D fea-
tures to automate this process, resulting in a drawing that is 80- to 90-percent
complete immediately after you import the raw field data. However, as is usu-
ally the case, the more automation you want, the more setup you're required
to perform. Automation is another way of saying that you're going to make a
bunch of decisions ahead of time and ask the computer to carry out those deci-
sions when needed.

The following Civil 3D features enable you to convert raw field data into
drawing information.
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A topographic map can
be thought of as a 3-D
map: the 2-D outlines
of surface features
combined with contour
lines representing the
third dimension.
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Linework Code Set

To create linear features using connected points, someone has to tell those features
when to start, when to end, when to draw curves, when to draw straight lines, and
so on. In other words, it can be a bit more complicated than “Draw a line from
point 1 to point 2.” Field crews use codes to carry out these geometric instructions.
For example, they might include the string BEG when locating the first point on

a fence line, which means to begin a new feature at that point. The linework code
set correlates these field codes with instructions that control the generation of
linework in the drawing. This is the way of telling Civil 3D that BEG means “begin
drawing here,” BCV means “begin curve here,” and so on. Another way to think of a
linework code set is as a translator between field language and Civil 3D language.

BN Exercise 3.3: Apply a Linework Code Set

If you haven't already In this exercise, you’ll assign a linework code set to your drawing and apply it to
done so, download points that have been imported.

and install the files for

Chapter 3 according to 1. Open the drawing named Linework Code Set.dwg located in the

the instructions in this Chapter 03 class data folder.

book’s Introduction.
2. Click the Survey tab of the Toolspace.

The Essentials 2 3. If the contents beneath the Essentials 2 survey database are not

database is the result visible, right-click Essentials 2 and select Open For Edit.
of correctly completing If you receive an error message here, you may not have installed the
e datasets correctly. Refer to the introduction for instructions on installing

This database is pro-
vided to ensure that

you start the current 4. Expand Import Events. Right-click Topo Survey.txt, and select
exercise with the cor- .
Properties.

rect version.
— 5. Click the Browse icon next to File to open the text file. Notice the
codes BEG, BCV, ECV, and END.
These are the codes used in the field to represent Begin Feature,
Begin Curve, End Curve, and End Feature. If you scroll down in the
text file, you'll also see the CLS code, which represents Close Feature.

the datasets.

6. Close the text file, and click Cancel to dismiss the Import Event
Properties dialog box.

Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.

E 7. Click the icon in the top-left corner of the Survey tab to edit the sur-
vey user settings.
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8. Click the Browse icon next to Linework Code Sets Path, browse to the
Chapter 03 class data folder, and click OK. Click OK to dismiss the
Survey User Settings dialog box.

9. On the Survey tab, right-click Linework Code Sets and select Refresh.
Click the plus sign next to Linework Code Sets. You should now see
Essentials listed as a linework code set.

10. Under Linework Code Sets, right-click Essentials and select Make Current.

11. Under Linework Code Sets, right-click Essentials and select Edit.
Notice that the codes used for Begin, End, Begin Curve, End
Curve, and Close now match what you saw in the text file. The codes
in the linework code set named Sample were different, and therefore
no linework was drawn when you imported the survey data.

12. Click Cancel to dismiss the Edit Linework Code Set dialog box.

13. Under Import Events, right-click Topo Survey.txt and select Process
Linework.

14. For Current Linework Code Set, select Essentials, and click OK.
15. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Linework Code Set - Complete.dwg. The survey database named Essentials 3
is provided for the next exercise and matches what you should have at the end of
this exercise.

Point Styles

Not all points are meant to be connected with other points. Some represent
stand-alone features such as power poles, manholes, or trees. These types of
features are typically represented with a symbol that either resembles their true
form or uniquely identifies them. With the Point Styles feature, a symbol can
be used to mark a point, meaning the likeness of a power pole, manhole, or tree
can be used instead of an x or a dot.

Point Label Styles

For some points, you might want labeling to be included automatically. For exam-
ple, you may want trees to be labeled with their common names or manholes to
be labeled with their top elevations. When the annotation is very uniform, point
label styles can be employed to provide the desired labels automatically.
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You should see a series
of lines appear in the
drawing. As you'll learn
later in this chapter,
these lines represent
features like tree lines,
fences, roads, and
streams.
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Certification
Objective

If you haven't already
done so, download
and install the files for
Chapter 3 according to
the instructions in this
book'’s Introduction.

A raw description is
usually the code that

is entered in the field,
and it’s often abbrevi-
ated to save time and
make it easier on field
crews under potentially
harsh conditions.

Chapter 3 « Establishing Existing Conditions Using Survey Data

Description Keys

As discussed, it takes a lot of points to capture several acres of land effectively. To
make things even more challenging, field crews often use abbreviated versions of
descriptions to represent points, such as EP for edge of pavement, CLRD for cen-
terline of road, and so on. The result is hundreds or even thousands of points all
clumped together and labeled with cryptic abbreviated descriptions.

Description keys solve this problem by automatically sorting the points onto the
appropriate layers, rewriting the abbreviated descriptions to full-length descrip-
tions, and automatically applying point styles to control the appearance of the
points. For example, a description key takes a point coded as PP, places it on the
utility layer, displays it as a power pole, and rewrites the description to say POWER
POLE. Imagine the time saved when this is done automatically for 10,000 points.

Exercise 3.4: Configure and Apply a
Description Key

In this exercise, you'll configure a description key for the tree points in your draw-
ing. You'll apply the description key and observe the automation that it enables.

1. Open the drawing named Description Keys.dwg located in the
Chapter 03 class data folder.

2. Click the Settings tab of the Toolspace, and expand Point >
Description Key Sets.

3. Right-click Essentials, and select Edit Keys.

»

Click the cell in the Style column for code TR* to open the Point
Style dialog box.

Select Tree as the point style, and click OK.
Click the green check mark to dismiss Panorama.

Click the Prospector tab, and then click Points.

® N S W

In the listing of points at the bottom of Prospector, scroll to the right
and click the Raw Description column heading to sort the points by
that property.

9. Scroll to the bottom of the list where all the TR points are now located.

10. Right-click one of the points, and select Apply Description Keys. One
of the points in the drawing should become a tree symbol.
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11. Select all the TR points, and use the Apply Description Keys com- K
mand to change them. All the trees in the drawing are now clearly

. . . The trees in the draw-
visible and appropriately represented. ¢ reesinhe craw

ing are now labeled,

12. Return to the Settings tab, and edit the Essentials description key set ~ aithough the labelis
the actual field code.

once again. This time, assign a point label style of Description Only A better result would
to the TR* code. Apply description keys to the TR points from within be a more polished
Prospector as you did earlier. description.

13. Edit the TR* description key code again, this time changing the
Format value to $1” $2 ($1mm $2).

14. Apply the description keys to the TR points again. This time, the
labels make more sense and read 12” (300 mm) PINE, 15” (375 mm)
MAPLE, and so on.

15. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Description Keys - Complete.dwg. No change was made to the survey data-
base during this exercise.

WHAT’Ss UP WITH THE DOLLAR SIGNS?

In the previous exercise, you used a code of $1” $2 to create the full description
for the trees. The $ is a special code that tells Civil 3D you want to use part of
the raw description in the full description. The parts of the raw description are
separated by spaces and numbered from left to right, starting at zero. Thus,
in the raw description TR 12 0AK, TR is $0, 12 is $1, and 0AK is $2. S0 $1” $2
becomes 12” 0AK. With metric values in the raw description TR 300 0AK, TR is
$0,300is $1,and 0AKis $2.S0 $1mm $2 becomes 300 mm OAK. This is a great
way for the person in the field to control the outcome in the drawing with as
few keystrokes as possible.

Figure Prefix Database

As discussed, the linework code set handles how field codes are translated into Certification
linework commands, but what happens to those features once they are drawn? Objective
What layer are they drawn on? Do they have any special purpose such as a
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If you haven't already
done so, download
and install the files for
Chapter 3 according to
the instructions in this

book’s Introduction.
bl
[=!

Note that some codes
are designated as
breaklines: EP (edge of
pavement), TOPD (top
of ditch), and TOB (top
of bank). These lines
can be used to define
hard edges in a surface
model.

>
>
The Essentials 3
database is the result
of correctly completing
the previous exercise.
This database is pro-
vided to ensure that
you start the current

exercise with the cor-
rect version.
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property line or breakline? The figure prefix database is the means by which
these decisions can be made up front for specific codes. For example, any feature
drawn through points coded EP (edge of pavement) will be drawn on the pave-
ment layer and tagged as a key component for establishing a hard edge in the
3D model of the terrain, also known as a breakline.

Exercise 3.5: Apply a Figure Prefix Database

In this exercise, you'll assign a figure prefix database to your drawing and apply
its settings to the linework in your drawing.

1.

10.

Open the drawing named Figure Prefix Database.dwg located in
the Chapter 03 class data folder.

. On the Survey tab of the Toolspace, click the Edit Survey User

Settings icon in the top-left corner.

. Click the Browse icon next to Figure Prefix Database Path. Browse to

and select the Chapter 03 class data folder, and then click OK.

Click OK to dismiss the Survey User Settings dialog box. Right-click
Figure Prefix Databases, and select Refresh. Click the plus sign next
to Figure Prefix Databases to expand its contents. You should now see
Essentials listed under Figure Prefix Databases.

Right-click Essentials, and select Make Current. Right-click
Essentials again, and this time, select Manage Figure Prefix
Database.

. Scroll down, and examine the codes in the Name column. These

match the codes you saw in the text file containing the survey data.

Click Cancel to dismiss the Figure Prefix Database Manager
dialog box.

. If the contents of the Essentials 3 survey database are not visible,

right-click Essentials 3 and select Open For Edit.

. Expand Import Events. Right-click Topo Survey.txt, and select

Process Linework.

In the Process Linework dialog box, select Essentials for Current
Figure Prefix Database and click OK. Civil 3D redraws the linework,
this time doing so on the appropriate layers. This is evident in the
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Automating Field-to-Finish

linetypes that are applied to the treelines and fence lines, which are
now appropriately represented on the drawing (see Figure 3.4).
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FIGURE 3.4 Theappearance of the drawing makes more sense now that
features such as fence lines and treelines have been drawn on the appropriate layers.

11. Save and close the drawing.

SURVEY FIGURES

At this point, you may be wondering what the word figure means or, specifi-
cally, what a survey figure is. A Civil 3D survey figure is the program’s way of
representing a linear feature that has been defined using survey data. A survey
figure is commonly used to represent visible features such as fence lines, edges
of pavement, and treelines as well as topographic features such as tops and bot-
toms of embankments. The topographic feature line layers are usually turned
off when the drawing is plotted. Survey figures can be referenced by other Civil
3D objects such as surfaces, feature lines, and corridors, enabling design work
to tie into existing features and topography, where applicable.
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You can view the results of successfully completing this exercise by open-
ing Figure Prefix Database - Complete.dwg. The survey database named
Essentials 4 is provided for the next exercise and matches what you should
have at the end of this exercise.

Point Groups

Point groups are another way of managing large amounts of point data. This
feature enables you to sort points based on a number of factors, such as descrip-
tion, elevation, point number, and manual selection. You can set up point
groups ahead of time so that points can be automatically sorted into groups as
they are imported into the drawing. You can also create new point groups on
the fly to sort points as you go.

Once points have been grouped, you can use them to study and manipulate
multiple points at once. The groups are listed in Prospector, and you can view
the points contained in each group simply by clicking the group name and
viewing the contents of the point group in the item view at the bottom (see
Figure 3.5). In addition, many point-editing commands allow you to select
points by group, enabling you to modify large numbers of points at once.

Ev g Master View

= Open Drawings i
ElD Point Groups - Complete

El @ Points

- Point Groups

. [@] Ground Shots

@[@] Breaklines

2] m -

pint Elevati... Mame Raw De’scripti.‘. Full Descri *
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|| b

FIGURE 3.5 Thecontentsofa specific point group shown in the item view of Prospector
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Point groups also enable you to assign default point styles and label styles to
points within the group. With this capability, you can make points in a certain
group take on specific graphical characteristics by controlling the point style
and point label style.

Exercise 3.6: Create and Apply Point Groups

In this exercise, you'll configure several point groups and use them to organize
points in your drawing as well as control their appearance.

1.

Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.

Open the drawing named Point Groups.dwg located in the Chapter 03
class data folder.

In Prospector, right-click Point Groups and select New.

On the Information tab of the Point Group Properties dialog box,
type Buildings in the Name field. Select Basic as the point style and
<none> as the point label style.

Click the Raw Description Matching tab. Check the box next to BLD*,
and click OK.

Expand Point Groups, and click the Buildings point group in
Prospector. Examine the list of points shown in the Prospector
item view at the bottom. Note that they all are points with a BLD
description.

Create the following point groups with the associated raw descrip-
tions listed. Use a default Point Style value of Basic and a default Point
Label Style of <None> for each point group:

» Breaklines: BOB, BOTD, SWL, TOB, TOPD
» Roads: CLRD, DW, EP, ES

» Vegetation: ESHB, TL, TR

» Fences: FNC

» Ground Shots: GS
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SECRET CODE?

You may be wondering what the raw descriptions mean in step 6 of Exercise 3.6.
What you see here are abbreviations for items that are commonly located in the
field by surveyors. In the interest of efficiency, abbreviated codes are typed in
the field instead of the full names of the features. Here is what these particular
examples stand for:

P Breaklines
» BOB: Bottom of bank
» BOTD: Bottom of ditch
» SWL: Swale
» TOB: Top of bank
» TOPD: Top of ditch
» Roads
» CLRD: Centerline of road
» DW: Driveway
» EP: Edge of pavement
> ES: Edge of shoulder
P Vegetation
» ESHB: Edge of shrub
P TL: Treeline
» TR: Tree
» Fences
» FNC: Fence
P Ground Shots
» GS: Ground shot

7. Click the Settings tab, and expand Point > Description Key Sets.
8. Right-click Essentials, and select Edit Keys.
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9. Hold down the Shift key to select all rows except the last one (TR*).
Then right-click the Style column heading, and select Edit.
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10.

11.

12.
13.
14.
15.

16.

Select <default>, and click OK. Click the green check mark to
close Panorama.

In Prospector, right-click the All Points point group and select Apply

Description Keys. This applies the new style choice of <default> to all
points except trees. Now the point style assigned by the point groups

is able to have an effect, and most of the points change from x mark-
ers to circle markers.

In Prospector, right-click the Ground Shots point group and select
Properties.

On the Information tab, select Ground Shot as the default point style
and Elevation Only as the default point label style. Click OK, and
notice what happens to all the ground shot points in the drawing.

Click the Output tab of the ribbon, and then click Export Points.

Check the box next to Limit Points To Point Group, and choose the
Roads point group.

Click OK, and browse to your Chapter 03 class data folder. Enter
Road Points as the name of the file, and click Open. Then click OK to
dismiss the Export Points dialog box.

17. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Description Keys - Complete.dwg. The survey database was not changed as a
result of this exercise.

Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.

PoiINT GROUPS VS. DESCRIPTION KEYS

At this point, you may be scratching your head a bit, thinking that a few minutes
ago you learned that description keys control the point style and point label style
assigned to a point. Well, you're right—they do. However, you may have also
noticed that when you assign these styles using description keys, the choice at
the top of the listin each case is <default>. This choice could (and maybe should)
be changed to say ByPointGroup, because that’s what it essentially means. When
you configure your description keys to use <default> as the style, you're deferring
the decision about what style to use for the point groups. If you choose anything
else, you're making that decision right then and there.

(Continues)
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You should find
<default> at the top of
the list. You may need
to scroll up.

All Points is a special
point group that must
existin all drawings.
As the name implies, it
always contains all the
points in the drawing.

This is an example of
using a group to make
a selection of points.
Imagine selecting all
these road points one
by one.

<
<
You have just created
afile that contains
only points in the
Roads point group.
You might do this ifa
road designer asks for
pointinformation on

aroad that has been
surveyed.
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PoINT GROUPS VS. DESCRIPTION KEYS (Continued)

Feel better about it? Well, unfortunately, there’s another feature to consider
that makes this a little more complicated but also gives you even more flexibility
when stylizing points. One of the properties of a point group is the ability to set
up an override. When you set up a point style or point label style as an override,
it means you're going to apply that style regardless of whether it’s <default>
or something else. The Overrides tab in the Point Group Properties dialog box
enables you to do this.

If you're wondering whether point groups or description keys are best to use, the
answer is both. By thoroughly understanding how each method can be applied
to your point data, you can use both point groups and description keys to stylize
and organize your points in the best way possible. When you're starting out,
however, you may want to pick one method or the other, completely develop
that method, and then sprinkle in the other method little by little, observing
and understanding how the two work together.

EVOLVE YOUR STANDARDS

In the previous exercises, you made some corrections and assigned a specific
linework code set and figure prefix database to the data you imported. In an
actual production environment, the changes you make to the description key
set should be incorporated into the company template so that the tree points
are handled correctly for all future jobs. The point groups you create could also
be included in the company template so that they're available on all future jobs.
In addition, the linework code set and figure prefix database that you use could
be assigned as defaults so that they are automatically applied to future data
imports. A CAD manager typically handles this type of configuration manage-
ment, but end users like you usually identify the needs for the changes. When
you're working with Civil 3D in a production environment, be sure to work with
your CAD manager to make sure you and your coworkers are leveraging the
configuration of Civil 3D as much as possible.

Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.
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Editing Survey Points

Editing Survey Points

As discussed, it takes many points to survey a piece of land—that’s hundreds
or even thousands of individual measurements and hand-typed field codes. On
nearly every project, there will be items that require editing. Once the data has
been imported into Civil 3D, the field crew is off to its next job, and the task of
fixing things up belongs to you.

For several reasons, editing survey points is a bit different from editing “regu-
lar” points, properly referred to as COGO points. One reason is that survey points
are considered “sacred” and are not typically moved or modified in any way
without considerable thought and/or the supervision of a surveyor. The second
reason, related to the first, is that Civil 3D uses a separate survey database sys-
tem to store points. The points in the drawing are essentially locked and can’t be
changed unless the information in the survey database changes. With this sys-
tem, a surveyor can send out the drawing file without sharing the survey data-
base that goes with it. When the points in the drawing are separated from the
survey database, they become locked and can’t be easily modified. In this way,
the survey database gives control of the points to the person who created them.

Exercise 3.7: Edit Survey Points

In this exercise, you'll edit a survey point to correct a field coding error. You'll dem-
onstrate that access to the survey database is necessary for editing survey points.

1. Open the drawing named Edit Survey Points.dwg located in the
Chapter 03 class data folder. If a survey database is open, right-click
it and select Close Survey Database.

2. Locate and zoom in to the red point along the west treeline, as shown
in Figure 3.6.

3. Open the Properties window, and then select the red point. Note that
there is a typo in the raw description. It should say TR 12 PINE (TR
300 PINE) instead of TTR 12 PINE (TTR 300 PINE). You can'’t edit
the raw description here because the data is stored in the survey
database.
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x
X
12" PINE - X
SXpE *

The survey database " +><"’
is needed to edit the
points. This is how the p x
points are kept safe o 5

when the drawing is bl
shared outside the

survey office. FIGURE 3.6 Anerrorhas caused this point to display incorrectly.

4. With the point still selected, click Survey Point Properties on the rib-
md bon. A dialog box opens, informing you that you must open a survey
database.

L >
I 5. Click OK to dismiss the dialog box. Then right-click the Essentials 4

) survey database on the Survey tab, and select Open For Edit.
The Essentials 4

database is the result ™ 6. With the red point still selected, click Survey Point Properties on
of correctly completing =7 the ribbon

the previous exercise. ’

This database is pro- 7. Edit the description to say TR 12 PINE (TR 300 PINE), and click OK.
vided to ensure that

you start the current
exercise with the cor-
rect version.

SURVEY PoOINTS vs. COGO PoOINTS

As previously mentioned, there are two types of points: COGO points and survey
points. How can you tell the difference? Here are a few characteristics of each
to help you distinguish between the two:

Survey Point Characteristics
» Only survey points are displayed on the Survey tab (COGO points are not).
P Survey points are displayed on both the Prospector and the Survey tabs.

» Survey points have an icon next to them that looks like a survey target
(an hourglass inside a box overlaid on crosshairs).

Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.

(Continues)
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SURVEY POINTS vs. COGO POINTS (Continued)

P Survey points cant be moved without accessing the survey database and
using specialized commands for editing survey points.

P Survey points can’t be edited in the Properties window.
COGO Point Characteristics
» (0GO points are not displayed on the Survey tab.

3= P (0G0 points have an icon next to them that looks like a circle overlaid
on crosshairs.

» (OGO points can be moved, even using basic, non-Civil 3D drafting
commands.

» (0GO points can be edited in the Properties window.

8. Press Enter to end the command. You're prompted to update line-
work in the drawing.

9. Click No to dismiss the Edit Survey Point Properties—Process
Linework dialog, because the change you made does not affect
linework.

10. Click the red point, right-click, and select Apply Description Keys.
11. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Edit Survey Points - Complete.dwg. The survey database named Essentials 5
is provided for the next exercise and matches what you should have at the end of this
exercise.

Editing Survey Figures

Mistakes in the field can lead to errors in the way linework is drawn. Once
again, the changes need to be made a certain way because you're dealing with
special survey objects, this time survey figures. Survey figures are linked to the
survey database, but unlike survey points, they can be edited without accessing
the survey database. If you edit survey figures in this way, you need to be aware
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that the objects you've edited are no longer in sync with the survey database.
When this occurs you should take steps to keep them in sync to ensure that the
correct data is used in the future.

I Exercise 3.8: Edit Survey Figures

If you haven't already In this exercise, you'll edit several survey figures to correct errors that took
done so, download place due to incorrect translation from the field to the drawing.

and install the files for

Chapter 3 according to 1.

the instructions in this
book’s Introduction.

> B

The Essentials 5

database is the result 3.
of correctly completing —

the previous exercise.

This database is pro-

vided to ensure that

you start the current

exercise with the cor- 4
rect version.

At this point, you could

back out and fix the 5
point description.

However, for the pur-

poses of this exercise,
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11.

you'll edit the figure = 6
instead. )

. In the Figure Properties dialog box, click point 288 and then click the

10.

Open the drawing named Edit Survey Figures.dwg located in the
Chapter 03 class data folder.

If the contents beneath the Essentials 5 survey database are not
visible, right-click Essentials 5 and select Open For Edit.

In the top-right viewport, locate the building that is missing its
north side. Click the building figure line, and then click Survey
Figure Properties on the ribbon. Notice that point 285 is missing a
CLS (close) code that would provide the north side of the building by
closing the rectangle.

. Click point 285 in the point list; then set the Closed value to Yes, and

click OK. The shape of the building is now closed. Because you used
the Survey Figure Properties command to edit this figure, the draw-
ing and the survey database are in sync.

. Press Esc to clear the previous selection. Pan to the southeast until

you can see the building to the west of the 6” (150 mm) pine. This
building should appear as two separate buildings.

Click the building figure, and then click Survey Figure Properties on
the ribbon.

red X icon. Remove points 289, 290, and 291 in the same manner.

. Click OK to close the Figure Properties dialog box. Now only the

north building is shown in the drawing.

. Right-click Figures on the Survey tab, and select Create Figure

Interactively.
When prompted, enter BLD2 as the figure name, and click OK.

Click the four points that make up the smaller building, and then
press Enter.
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Creating Additional Points

12. In the Figure Properties dialog box, set the Closed value to Yes. If
necessary, adjust the order of the points using the arrow buttons.
Click Apply and then OK when the blue figure outline appears as
a rectangle in the drawing. The building figure now appears as it
should, and the two separate buildings are represented properly, as
shown in Figure 3.7.

FIGURE 3.7 Theresultof editing the building figures

13. Save and close the drawing.

You can view the results of successfully completing this exercise by
opening Edit Survey Figures - Complete.dwg. The survey database named
Essentials 6 is provided for the next exercise and matches what you should
have at the end of this exercise.

Creating Additional Points

You may occasionally need to create your own points to establish key locations
in the drawing. For example, early in the design, you may want to show specific
locations for proposed test borings or property corners that need to be found.
Another example is that you may have a point file that you would like to import
into the drawing without including it in a survey database. Civil 3D has a multi-
tude of tools designed to create points easily and efficiently. They are found on a
special toolbar that opens when you click the Point Creation Tools command on
the Home tab of the ribbon.

In many ways, the points you create using these tools are treated in the same
manner as those created by importing survey data. They can be placed in point
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Chapter 3 according to
the instructions in this
book'’s Introduction.

Stake out is a term used
by surveyors to refer to
placing markers in the

field at predetermined
locations, often calcu-

lated in the office.

There are pointsin

the drawing that have
the same numbers as
the points that are
being imported. This is
resolved by using the
Add An Offset option
to increase the incom-
ing point numbers by
1,000.

Chapter 3 « Establishing Existing Conditions Using Survey Data

groups and can respond to description keys. They can also be affected by point
styles and point label styles. There are differences, however, between these
points and those created by importing survey data. For example, Civil 3D can’t
automatically generate linework by importing points in this manner. Also, these
points don’t have the protection of the survey database, allowing them to be
edited by anyone who opens the drawing. Regardless of how they are created,

all points can be exported to a file that can be uploaded to a portable device and
taken to the field to be staked out.

Exercise 3.9: Import Points and Create
Points Manually

In this exercise, you’ll begin by importing points that represent property cor-
ners that were found on the site. Then you'll create stake-out points to assist
field crews in locating several missing property corners. You'll also create points
along the proposed road centerlines. These points will represent the locations of
soil-test borings to be performed on the site.

1. Open the drawing named Stake Out.dwg located in the Chapter 03
class data folder.
This drawing contains a calculated property boundary recon-
structed from a deed or other source of information. It also contains
a preliminary layout of the road centerlines that will be used to deter-
mine soil-test boring locations. You’'ll begin by inserting points into
the drawing that represent property corners located in the field.

2. On the Insert tab of the ribbon, click Points From File.

. In the Import Points dialog box, select PNEZD (Comma Delimited)
as the format. Then click the plus sign icon and browse to the
Chapter 03 class data folder.

4. For Files Of Type, select the Text/Template/Extract File (*.txt) option.
Then select Found Corners.txt, and click Open.

5. Click OK to dismiss the Import Points dialog box.

6. In the Duplicate Point Number dialog box, under Resolution, select
Add An Offset. Type 1000 in the box below Add An Offset From, and
click OK.
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7.

10.

11.

12.
13.
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14.

15.

16.
17.
18.
19.

In Prospector, expand Point Groups. Right-click Found Corners, and
select Update.

This applies the default styles from the point group to the newly
imported points. Found corners appear with red markers and text.
Notice that two points are missing along the south property bound-
ary as well as one point on the east property boundary and one at
the northwest corner (four points in all). Finding and locating these
corners in the field will greatly improve the accuracy and validity of
the property survey.

On the Home tab of the ribbon, click Points > Point Creation Tools.

On the Create Points toolbar, click the button on the far left to launch
the Miscellaneous Manual tool. In the left viewport, snap to the loca-
tions of the missing points.

In Prospector, right-click the Corners To Be Found point group and
select Update.
These points display in blue.

On the Create Points toolbar, click the chevron on the far right to
expand the toolbar.

Expand Points Creation, and enter BORE as the default description.

Click the down arrow on the button farthest to the left, and then
click Measure Object.

Click one of the magenta road centerlines. Press Enter three times to
accept the default starting station, ending station, and offset.

Type an interval of 250 (80), and press Enter. The points are created
at a 2507 (80-m) interval along the polyline you've selected.

In Prospector, update the Test Borings point group.
Repeat steps 13 to 16 for the remaining road centerlines.
On the Output tab of the ribbon, click Export Points.

For format, select PNEZD (Comma Delimited). Check the box next to
Limit To Points In Point Group, and select Corners To Be Found.
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64
I 20. Click OK, and browse to the Chapter 03 class data folder. Specify a

filename of Corners to be Found.txt.
This file could be sent
to asurveyor to help 21. Repeat steps 19 to 21 for the Test Boring point group to create a Test
locate the missing Borings.txt point file.
points in the field.
22. Save and close the drawing.

> You can view the results of successfully completing this exercise
This file could be sent by opening Stake Out - Complete.dwg. There was no change to the
to a geotechnical survey database as a result of this exercise.
company so that they
can stake out the test

borings in the correct

location.
Now You Know

Now that you have completed this chapter, you understand the world of survey data as it exists
in the Civil 3D environment. You understand that survey data must reside in a survey database
that exists separately from the drawing file. You know how to import data into the survey
database and display it in your drawing as points and linework. You know how to automate
the organization and graphical properties of the points and linework using linework code sets,
description keys, the figure prefix database, and point groups. You can edit survey points and
survey figures by accessing the survey database and making changes using the appropriate
tools. Finally, you know several additional methods for importing points and creating them
manually.

With the knowledge and skills you have gained in this chapter, you're ready to begin working
with survey data in Civil 3D: turning it from raw field data into a drawing representing the
existing conditions of a project.
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